
BAB 18

Lembar Jawaban

18.1 Hasil Untuk Menambahkan Layer Pertama Anda

18.1.1 Persiapan

Anda akan melihat banyak garis yang melambangkan jalan. Semua garis tersebut merupakan

layer vektor yang baru saja Anda muat untuk membuat peta dasar.

Kembali ke teks

18.2 Hasil Untuk Gambaran Umum Antarmuka

18.2.1 Tinjauan (Bagian 1)

Lihat kembali gambar yang menunjukkan tata letak antarmuka dan periksa bahwa Anda meng-

ingat nama-nama dan fungsi dari unsur-unsur layar.

Kembali ke teks

18.2.2 Tinjauan (Bagian 2)

1. Save as

2. Zoom to layer

3. Help

4. Rendering on/off

5. Measure line

Kembali ke teks
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18.3 Hasil Untuk Pekerjaan dengan Data Vektor

18.3.1 Shapefiles

Harus terdapat dua layer pada peta Anda:

• places dan

• streets.

Kembali ke teks

18.3.2 Basis data

Semua layer vektor harus dimuat ke dalam peta. Saat ini mungkin data-data tersebut belum

akan terlihat bagus untuk dilihat:

(Kita akan memperbaiki warna yang jelek ini nanti.)

Kembali ke teks
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18.4 Hasil Untuk Simbologi

18.4.1 Warna

• Pastikan bahwa warna telah berubah seperti yang Anda harapkan.

• Hal ini hanya untuk mengubah layer rural untuk saat ini. Contohnya adalah di bawah ini,

tetapi dapat terlihat berbeda tergantung pada warna yang Anda pilih.

Catatan: Jika Anda ingin bekerja hanya pada satu layer pada satu waktu dan tidak ingin layer
lain mengalihkan perhatian Anda, Anda dapat menyembunyikan layer dengan mengklik pada

kotak cek di sebelah nama dalam daftar layer. Jika kotak tersebut kosong, maka layer telah

tersembunyi.

Kembali ke teks
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18.4.2 Struktur Simbol

Dilihat secara bersamaan, layer rural dan urban Anda akan terlihat kurang lebih seperti ini:

Jika Anda adalah pengguna pada level pemula, Anda sebaiknya berhenti disini.

• Gunakan metode di atas untuk mengubah warna dan gaya untuk semua layer yang tersisa.

• Coba gunakan warna-warna alami untuk objek. Misalnya, jalan tidak boleh merah atau

biru, tetapi bisa digunakan warna abu-abu atau hitam.

• Juga jangan ragu untuk bereksperimen dengan Fill Style dan pengaturan Border Style

yang berbeda untuk poligon.

Kembali ke teks

18.4.3 Layer Simbol

• Sesuaikan layer yang Anda inginkan, tetapi ingat bahwa itu harus memudahkan untuk

mengetahui layer yang berbeda selain pada peta.

Berikut ini contohnya:
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Kembali ke teks

18.4.4 Level Simbol

Untuk membuat yang diperlukan, Anda membutuhkan setidaknya tiga layer simbol:
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Layer yang paling rendah adalah simbol lebar, garis kuning yang padat. Di atasnya adalah garis

yang sedikit lebih tipis keabu-abuan atau hitam gelap padat. Layer simbol di atas adalah garis

putus-putus putih yang tipis.

• Jika layer simbol Anda menyerupai yang ada di atas tetapi Anda tidak mendapatkan hasil

yang sesuai dengan yang Anda inginkan, periksa bahwa level simbol Anda terlihat seperti

ini:
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• Sekarang simbol Anda seharusnya terlihat seperti ini:
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• Pada peta Anda akan memberikan efek semacam ini:
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Kembali ke teks

18.4.5 Level Simbol

• Aturlah level simbol Anda untuk hasil seperti ini:
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• Cobalah dengan nilai berbeda untuk memperoleh hasil yang berbeda.

• Buka peta asli Anda kembali sebelum melanjutkan dengan latihan selanjutnya.

Kembali ke teks

18.5 Hasil Untuk Data Atribut

18.5.1 Data Atribut

Field NAME paling banyak digunakan sebagai label. Hal ini dikarenakan semua nilainya unik

untuk setiap objek, dan ini tidak berisi nilai “null” (misalnya fields tanpa nilai).

Kembali ke teks.

438 Bab 18. Lembar Jawaban



Quantum GIS Training Manual, Rilis 1.0

18.6 Hasil Untuk Piranti Label

18.6.1 Pengaturan Label (Bagian 1)

Peta Anda seharusnya terlihat seperti ini:

Kembali ke teks

18.6.2 Pengaturan Label (Bagian 2)

Salah satu solusi yang mungkin untuk hasil akhir:

Untuk sampai pada hasil ini:

• Gunakan jenis font Arial ukuran 10 dan Label distance dari 1,5 mm.
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• Selain itu, contoh ini menggunakan pilihan Wrap label on character :

• Masukkan space pada field ini dan klik Apply untuk memperoleh efek yang sama.

Kembali ke teks

18.6.3 Menggunakan Pengaturan Data yang Ditetapkan

• Masih dalam mode edit, aturlah nilai FONT_SIZE ke apapun yang lebih Anda inginkan.

Contoh ini menggunakan 12 kota, 10 untuk pinggiran kota dan desa, dan 8 untuk entri

null.

• Ingatlah untuk menyimpan perubahan dan keluar dari mode edit.

• Dalam Data defined settings, lakukan ini:

Hasil Anda, jika menggunakan nilai di atas, seharusnya seperti ini:
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Kembali ke teks

18.7 Hasil Untuk Klasifikasi

18.7.1 Mempertajam Klasifikasi

• Gunakan metode yang sama seperti pada latihan pertama dari pelajaran ini untuk me-

nyingkirkan baris:
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Pengaturan yang Anda gunakan mungkin tidak sama, tetapi nilai Classes = 7 dan Mode =

Natural Breaks (Jenks) ( dan gunakan warna yang sama), peta tersebut akan terlihat seperti ini:
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Kembali ke teks

18.8 Hasil Untuk Pembuatan Vektor Dataset Baru

18.8.1 Mendigitasi

Simbologi tidak masalah, tetapi hasilnya akan terlihat seperti ini:
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Kembali ke teks

18.8.2 Topologi: Hindari Persimpangan

Peta Anda seharusnya terlihat seperti ini:

444 Bab 18. Lembar Jawaban



Quantum GIS Training Manual, Rilis 1.0

Kembali ke teks

18.8.3 Topologi: Menambahkan Lingkaran Piranti

Bentuk yang tidak terlalu tepat tidak terlalu masalah, tetapi Anda harus mendapatkan lubang

pada feature Anda, seperti ini:
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• Ulangi pengeditan Anda sebelum melanjutkannya dengan latihan untuk piranti selanjut-

nya.

Kembali ke teks

18.8.4 Topologi: Menambahkan Bagian Piranti

Bentuk dan lokasinya yang tidak tepat tidak masalah, tetapi Anda harus mendapatkan tambahan

bagian pada feature Anda, seperti ini:
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• Perlu diperhatikan bahwa pertama-tama Anda harus melakukan seleksi pertanian dengan

piranti seleksi ...

... sehingga QGIS tahu feature mana yang digunakan untuk menambahkan bagian baru.

• Ulangi pengeditan Anda sebelum melanjutkannya dengan latihan untuk piranti selanjut-

nya.

Kembali ke teks
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18.8.5 Menggabungkan Feature

• Gunakan feature dengan id 1237 sebagai sumber dari atribut Anda (klik pada entri pada

kotak dialog ini, kemudian klik tombol the Take attributes from selected feature ):

• Menggunakan Merge Selected Features akan menggabungkan atribut sebagaimana geo-

metrinya:
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Sedangkan Merge Merge Attributes of Selected Features akan menjaga geometri yang

berbeda, tetapi memberikan atribut yang sama.

Kembali ke teks

18.8.6 Formulir

Untuk TYPE, ada jumlah yang terbatas untuk jenis yang jalan, dan jika Anda memeriksa tabel

atribut untuk layer ini, Anda akan melihat bahwa mereka yang telah ditetapkan.

• Mengatur widget ke Unique values dan meninggalkan Editable sebagai False:

• Sebuah jalan merupakan jalan satu arah atau bukan, maka ONEWAY harus dipilih pada

Checkbox.

Melihat tabel atribut untuk streets, nilai ketika tidak satu arah tampaknya menjadu NULL, dan

ketika satu arah, maka yes.

• Lihat nilai berikut:
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• Jika Anda menggunakan piranti Identify pada jalan sekarang ketika mode edit sedang

aktif, dialog box yang Anda dapatkan akan terlihat seperti ini:
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Kembali ke teks

18.9 Hasil Untuk Analisis Vektor

18.9.1 Menemukan Jalan Penting

Layer Anda sekarang harus mempunyai jalan-jalan berikut:

• Simpan layer baru ini (dengan cara yang sama seperti sebelumnya) di da-

lam folder exercise_data/residential_development/, sebagai

important_roads.shp.

• Setelah layer baru ditambahkan pada peta Anda, hapus layer yang lama.

• Jika untuk beberapa alasan, memberikan Anda pesan error yang menyatakan bahwa layer

tersebut tidak dapat ditambahkan ke peta (hal tersebut dapat terjadi), ingatlah bahwa An-

da dapat menambah layer Anda sendiri dengan menggunakan tombol Add Vector Layer

seperti yang telah dilakukan sebelumnya.

Kembali ke teks.
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18.9.2 Jarak dari Sekolah Tinggi

• Dialog buffer Anda harus tampak seperti berikut:

Buffer distance sebesar 10000 meter (misalnya 10 km).

• Nilai Segments to approximate diatur menjadi 20. Hal tersebut merupakan pilihan, tetapi

hal tesebut direkomendasikan karena akan menghasilkan hasil buffer yang lebih halus.

Bandingkan ini:
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Dengan ini:
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Lingkaran merah adalah buffer dengan Segments to approximate diatur senilai 20; ling-

karan berwarna abu-abu di atasnya adalah buffer dengan Segments to approximate diatur

seniali 5.

Kembali ke teks.

18.10 Hasil Untuk Analisis Raster

18.10.1 Menghitung Aspect

• Atur dialog DEM (Terrain analysis) Anda seperti berikut:
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Hasil Anda:
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Kembali ke teks.

18.10.2 Menghitung slope (kurang dari 2 dan 5 derajat)

• Atur dialog Raster calculator Anda seperti berikut:
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• Untuk versi 5 derajat, ulangi nilai 2 dalam ekspresi di atas dengan nilai 5.

Hasil Anda :

• 2 derajat:
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• 5 derajat:
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Kembali ke teks

18.11 Hasil Untuk Melengkapi Analisis

18.11.1 Raster ke Vektor

• Buka dialog Query dengn klik pada layer all_terrain dalm Layers list.

• Kemudian buat query "suitable" = 1.

• Klik OK untuk menyaring semua poligon dimana kondisi ini tidak bertemu.

Ketika terlihat di atas raster asli, area harus overlap dengan sempurna:
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• Anda dapat menyimpan layer ini dengan mengklik kanan pada layer all_terrain pada

Layers list dan pilih Save As..., kemudian lanjutkan tiap instruksi.

Kembali ke teks

18.11.2 Memeriksa Hasil

Pada peta ini, lahan pertanian sudah jelas yang tidak sesuai berwarna oranye; lahan pertanian

yang sesuai berwarna biru:
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Pertanian dengan warna oranye memiliki terain yang hampir tidak sesuai dengannya, jadi tidak

dapat digunakan untuk tujuan tersebut.

Kembali ke teks

18.11.3 Menyuling Analisis

Saat ini, analisis Anda harus tampak seperti berikut (abaikan simbologi):
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Pertimbangkan daerah lingkaran, lanjutkan dengan 350 meter ke semua arah.

Jika lingkaran tersebut lebih luas dari 350 meter jaraknya, kemudian kurangkan 350 meter dari

ukurannya ( dari semua arah) dan akan menghasilkan bentuk dengan dengan bagian lubang

tengah-tengah.
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Oleh karena itu, Anda dapat menjalankan interior buffer dari 350 meter pada layer vektor

suitable_terrain. Pada hasil keluaran fungsi buffer, apa pun yang tersisa dari layer asli akan

mewakili wilayah yang cocok untuk terrain di luar 350 meter.

Untuk menunjukkan:

• Klik Vector → Geoprocessing Tools → Buffer(s) untuk membuka dialog Buffer(s).

• Atur seperti berikut:
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• Gunakan layer suitable_terrain dengan segment 10 dan jarak buffer -350. (Jaraknya

secara otomatis dalam meter karena peta Anda menggunakan sistem referensi yang terp-

royeksi.)

• Simpan hasilnya dalam folder exercise_data/residential_development/

sebagai suitable_terrain_continuous350m.shp.

Hasil Anda akan tampak seperti berikut:
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• Sekarang gunakan tool Select by Location (Vector → Research Tools → Select by loca-

tion).

• Atur seperti berikut:

• Pilih fitur dalam new_solution yang berpotongan dengan feature dalam suita-

ble_terrain_continuous350m.shp.
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Berikut adalah hasilnya:

Lahan pertanian dengan warna kuning adalah yang dipilih.

• Simpan hasil yang terpilih tersbut dalam folder

exercise_data/residential_development/ sebagai

final_answer.shp.

Pertanian yang memenuhi kriteria yang telah direvisi adalah :
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Kembali ke teks.

18.12 Hasil Untuk WMS

18.12.1 Menambah layer WMS yang lain

Peta Anda seharusnya terlihat seperti ini:
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Kembali ke teks.

18.12.2 Menambah Server WMS baru

• Gunakan pendekatan yang sama seoeri sebelumnya untuk menambah server baru dan

sediakan layer sebagai tuan rumah pada server tersebut:
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• Jika Anda memperbesar ke daerah Swellendram, Anda akan menyadari bahwa dataset

ini memiliki resolusi yang rendah:

Oleh karena itu, akan lebih baik untuk tidak menggunakan data ini untuk peta saat ini. Data

Gundukan berwarna biru lebih sesuai pada skala nasional atau dunia.

Kembali ke teks

18.12.3 Menemukan Server WMS

Anda mungkin memperhatikan bahwa banyak server WMS yang tidak selalu tersedia. Ka-

dang hal tersebut hanya sementara, tetapi kadang juga permanen. Sebuah contoh dari se-

rver WMS yang bekerja pada saat penulisan adalah WMS World Mineral Deposits dalam

http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. WMA ter-

sebut tidak memerluan biaya atau mempunyai akses konstrain, dan WMS terbelut bersifat glo-

bal. Oleh karena itu, WMS tersebut memenuhi persyaratan. Perlu diingat, meskipun demikian,

WMS tersebut hanya sebuah contoh. Ada banyak server WMS lainnya yang bisa dipilih.

Kembali ke teks
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18.13 Hasil Untuk Queri Spasial

18.13.1 Satuan yang digunakan dalam Queri Spasial

Satuan yan digunakan dalam query contoh adalah derajat, karena sistem proyeksi pada layer

menggunakan WGS 84. WGS 84 merupakan Sistem Proyeski Geografis, yang berarti satuan-

nya adalah derajat. Sistem proyeksi yang telah terproyeksi seperti proyeksi UTM, dalam satuan

meter.

Ingatlah bahwa ketika Anda menulis sebuah query, Anda perlu mengetahui satuan apa yang

sesuai dengan sistem referensi. Hal tersebut akan memungkinkan Anda untuk menulis query

yang aka menghasilkan hasil yang Anda harapkan.

Kembali ke teks

18.13.2 Membuat indeks spasial

CREATE INDEX cities_geo_idx

ON cities

USING gist (the_geom);

Kembali ke teks

18.14 Hasil Untuk Konstruksi Geometri

18.14.1 Membuat Linestring

alter table streets add column the_geom geometry;

alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = ’ST_LineString’::text OR the_geom IS NULL);

insert into geometry_columns values (’’,’public’,’streets’,’the_geom’,2,4326,

’LINESTRING’);

create index streets_geo_idx

on streets

using gist

(the_geom);

Kembali ke teks
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18.14.2 Menghubungkan tabel

delete from people;

alter table people add column city_id int not null references cities(id);

(merekam cities dalam QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)

values (’Faulty Towers’,

34,

3,

’072 812 31 28’,

1,

’SRID=4326;POINT(33 33)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)

values (’IP Knightly’,

32,

1,

’071 812 31 28’,

1,

’SRID=4326;POINT(32 -34)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)

values (’Rusty Bedsprings’,

39,

1,

’071 822 31 28’,

1,

’SRID=4326;POINT(34 -34)’);

Jika Anda mendapatkan pesan kesalahna seperti berikut:

ERROR: insert or update on table "people" violates foreign key constraint

"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

Pesan tersebut berarti bahwa ketika membuat polygon untuk table cities, Anda harus mengha-

pus beberapa poligon dari tebale tersebut dan memulianya lagi. Periksa data masukan dalam

tabel cities Anda dan gunakan sembarang id yang sudah ada.

Kembali ke teks
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18.15 Hasil Untuk Simple Feature Model

18.15.1 Mengisi tabel

create table cities (id serial not null primary key,

name varchar(50),

the_geom geometry not null);

alter table cities

add constraint cities_geom_point_chk

check (st_geometrytype(the_geom) = ’ST_Polygon’::text );

Kembali ke teks

18.15.2 Mengisi tabel the Geometry_Columns

insert into geometry_columns values

(’’,’public’,’cities’,’the_geom’,2,4326,’POLYGON’);

Kembali ke teks

18.15.3 Menambahkan Geometri

select people.name,

streets.name as street_name,

st_astext(people.the_geom) as geometry

from streets, people

where people.street_id=streets.id;

Hasil:

name | street_name | geometry

------------------+-----------------+---------------

Rusty Bedsprings | High street |

QGIS Geek | High street |

Joe Bloggs | New Main Street |

IP Knightly | QGIS Road |

Fault Towers | QGIS Road | POINT(33 -33)

(5 rows)

Sebagaimana yang Anda lihat, konstrain kita memungkinkan nilai null dapat ditambahkan de

dalam basis data.

Kembali ke teks
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